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Agenda

* Ul design

 Traditional CSS Box model

* Block-level and inline element
* Parent/child relationships

* Vendor prefixes

* CSS Flexbox Box model
 CSS Crid Layout model
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Vendor Prefixes

* CSS3 specification is still in draft format and
undergoing modifications

* Need to use vendor prefixes with several
CSS3 constructs
= Internet Explorer uses the -ms- prefix.
= Firefox supports the -moz- prefix.
= Chrome and Safari support the ~webkit- prefix.

—Operastpportsthe—o—pretee
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Two CSS box models

Box models

1.In the W3C box model, the width of an element gives the width of the content of the box,
excluding padding and border.

2.In the traditional box model, the width of an element gives the width between
the borders of the box, including padding and border.

By default, all browsers use the W3C box model, with the exception of IE in "Quirks Mode"
(IE5.5 Mode), which uses the traditional one.

Traditional box model Ma rgin
box-sizing: border-box |J Paddi
\\\\ adding
border padding Content
< width: 250px; »

W3C box model

box-sizing: content-box
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Box model sample

<div class="use-content-box"> Content-box model </di\'HTML a div {
<div class="use-border-box"> Border-box model </div> background: aqua;
width: 100px;
height: 100px;
border: 1px solid black;
padding: 20px;
margin: 20px;
}
.use-content-box {
box-sizing: content-box;
}
.use-border-box {
box-sizing: border-box;

JAVASCRIPT &

http://jsfiddle.net/koldovsky/e1984en9/1/
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Inherited Properties

* A parent box can contain one or Parent box
more child boxes.

A child can inherit CSS styles from
a parent.

Sample inherited property:
p { color: green }
<p>This paragraph has <em>emphasized text</em> in it.</p>

* Sample non-inherited property:

p { border: medium solid }
<p>This paragraph has <em>emphasized text</em> in it.</p>

* Using inherit property:
/* make second-level headers green */
h2 { color: green; }
/* ...but leave those in the sidebar alone so they use their

parent's color */
#sidebar h2 { color: inherit; }
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Browser Default Styles

* Web browsers have default CSS styles for HTML
elements, consider sample:

* Also these styles are ditferent for different
browsers, so same markup may look ditferent

* To ensure same markup looks the same it is
recommended to use "reset” or "normalize”
stylesheets (second is preferred):

= Reset CSS:
= Normalize CSS:
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Media Queries

* A media query consists of a media type and at least one expression
that limits the style sheets' scope by using media features, such as
width, height, and color.

* Media queries allow to create responsive websites

® Details: https://developer.mozilla.org/en-US/docs/Web/CSS/Media_Queries/Using_media_queries

<!-- CSS media query on a link element -->
<link rel="stylesheet"” media="(max-width: 800px)" href="example.css" />

<!-- CSS media query within a stylesheet -->
<style>

@media (max-width: 600px) {
.facet _sidebar {
display: none;
}

}
</style>

» Sample: http://plnkr.co/edit/XYTDjomz5|NAvpQjt6LZ?p=preview
* Some issues with media queries: it's not so simple to reorder blocks
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Ul Challenges

* Developers have used float property for
relative positioning of Ul elements for years

* CSS3 Provides two new options:

= CSS3 Flexbox Box model ideal for items that should
resize or reposition themselves

= CSS3 Grid Layout model good for complex layouts
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CSS Flexbox Box Model

* Good for controls, toolbars, menus, and forms
that resize and reposition automatically when
the user changes the size of the browser
window

* Browser takes the available space into account
and calculates the dimensions for the user

* Enables relative sizes and positioning
» Good tutorial:
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CSS Flexbox Model Reordering Sample

* http://jstiddle.net/koldovsky/jb5h57jw/

<div id="flex"> HTML QA #flex { display: flex; }
<div id="a">A</div> #flex > #a { order: 2; }
<div id="b">B</div> #flex > #b { oxder: 1; }
<div id="c">C</div> #flex > #c { oxder: 3; }
</div> v

JAVASCRIPT ©

BAC

Empowering your Business
s SOfts e rve through Saf{ware Development



CSS3 Grid Layout Model

* Gives developers greater
control over complex layouts
than the flexbox model

* Lets you control the design of
sections or entire HTML-based
documents using CSS3

» Grid layouts use columns, rows, and cells, but
you can move blocks of content from one part
of page or application to another by moving
code lines in CSS
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Multi-column Layout

* Create columns by dividing text across
multiple columns

» Specity the amount of space that appears
between columns (the gap)

* Make vertical lines (rules) appear between
columns

e Define where columns break
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Multi-column Layout

* Main CSS properties for creating multiple columns
in an HTML document:
= column-count: Sets the number of columns

=Alternative: Use columns property with
column-count and column-width properties
= column-gap: Specifies the gap between the
columns, known as the gutter or alley

= column-rule: Creates a vertical line in the gap
between columns and sets the width, style (single
or double line, solid, dashed, 3D, etc.) and color of
the rule
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S SoftServe

Multi-column Layout Example

Spa HTML €&
Lorem ipsum dolor sit amet, consectetur adipiscing
elit. Mauris gravida congue sem id venenatis. Donec
blandit interdum sem. Duis eu risus ut erat commodo
semper. Quisque nec blandit odio, quis tincidunt dui.
Maecenas nec elit finibus magna sodales luctus eget
nec massa. Suspendisse at dolor in ligula ullamcorper
vehicula. Nullam pretium fermentum lacinia. Aliquam
sodales nisl justo, nec finibus enim accumsan eget.
Maecenas vulputate urna vitae tellus tincidunt
vestibulum. Integer mi metus, consectetur eget
consectetur sit amet, sodales id lectus. Aliquam
commodo nisi id volutpat venenatis. Nulla quis mi
laoreet, aliquet velit sed, egestas massa.

Praesent ac enim neque. Ut lorem ex, egestas in
mattis vitae, sagittis aliquam ante. Morbi nec sem
ultricies, suscipit diam vitae, fermentum est. In id
lectus placerat, faucibus enim sed, gravida enim. In
commodo eros at ligula malesuada, id vulputate orci
feugiat. Proin id euismod nunc, et vestibulum purus.

Susnendisse maximus sem sit amet libero conseauat. et ~

JAVASCRIPT &
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p {column-count: 3;

-ms-column-count: 3;

-webkit-column-coun
-moz-column-count:

Lorem ipsum dolor sit amet,
consectetur adipiscing elit.
Mauris gravida congue sem
id venenatis. Donec blandit
interdum sem. Duis eu risus
ut erat commodo semper.
Quisque nec blandit odio,
quis tincidunt dui.
Maecenas nec elit finibus
magna sodales luctus eget
nec massa. Suspendisse at
dolor in ligula ullamcorper
vehicula. Nullam pretium
fermentum lacinia. Aliquam
sodales nisl justo, nec
finibus enim accumsan
eget. Maecenas vulputate
urna vitae tellus tincidunt
vestibulum. Integer mi
metus. consectetur eget

o
e,

&y

S
1

eu in nibh. In mollis eros et
sollicitudin 1aculis. Aliquam
erat volutpat. Nulla vel risus
sit amet nisi commodo
mollis eu eget lacus. Sed
volutpat mauris velit, sit
amet dictum felis mollis a.
Praesent vitae ante id purus
scelerisque malesuada. Ut
commodo volutpat iaculis.
Maecenas sodales maximus
neque non dignissim. Fusce
vel ipsum at nibh facilisis
condimentum eu in nunc.
Phasellus efficitur, arcu ac
convallis dignissim, nisl mi
consequat elit, eu mattis mi
nunc sed elit. Duis lacinia
justo at nisi consequat
semper. Ut aliquet

CSS &

dolor vulputate, in dapibus
risus faucibus. Aliquam erat
volutpat. Donec iaculis
mauris enim, non feugiat
neque sodales in. Vivamus
porta ex quis rhoncus
sollicitudin. Etiam ut lacus
non sem tristique aliquet sit
amet vel sem. Suspendisse
sed neque luctus, ultricies
lacus nec, pharetra mauris.
Praesent nec ligula at ex
condimentum tempus vel
non est. In gravida leo non
urna suscipit finibus.
Integer quis nibh eu urna
auctor ullamcorper in vitae
ipsum. Pellentesque mattis
eleifend erat vitae laoreet.
Etiam venenatis. urna in




Practice Task:

Explore hitp://learnlavout.com/

Use different approaches to create leyouts
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Learn CSS Layout

This site teaches the CSS fundamentals that are used in any website's
layout.

| assume you already know what selectors, properties, and values are.
And you probably know a thing or two about layout, though it may still be
a rage-provoking activity for you. If you want to learn HTML and CSS
from the beginning, you should check out this tutorial. Otherwise, let's
see if we can save you some fury on your next project.

Get Started

english espafiol francais deutsch dutch italiano
portugués (brasil) portugués (portugués) pycckui

s P ERRHX B0 HAGR



Hyphenation

* The process of connecting two words with a hyphen
mark (-) or breaking words between syllables at the
end of a line.

* CSS3 hyphens property controls hyphenation
* Values:

= auto: Enables automatic hyphenation of words based
on line-break opportunities within words or by a
‘language-appropriate hyphenation resource”

= manual: Enables hyphenation of words based only on
line-break opportunities within words

= none: Prevents hyphenation

Empowering your Business
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Language Declaration

* W3C requires a language declaration for
correct automatic hyphenation to occur:

<!doctype html>
<html lang="en-us'">

or

<html
xmlns="http://www.w3.0rg/1999/xhtml"

xml:lang="en" lang="en">

Empowering your Business
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border-radius Property

* Creates rounded corners around layout
elements, like headers, footers, sidebars,
graphics boxes, and outlines around images

* border-radius is a length, which is usually
expressed in pixels or ems but can be a
percentage

Empowering your Business
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border-radius Example

<!doctype html>

<html>

<head>
<meta charset="utf-8" />

<title>Rounded Corners</title>

<style type="text/css">

div {
padding: 40px 40px;
background: dodgerblue;
width: 400px;
color: #fff;
font-family: sans-serif;
font-size: xx-large;
border-radius: 25px;
margin-left: auto;
margin-right: auto;
margin-top: 100px;

}

</style>

</head>

<body>

<div>A box with rounded corners</div>
</body>
</html>

Empowering your Business
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border-radius Example

PR
@w

@ nttp://localhost:55685/ O ~ B ¢ X

@ Rounded Corners

A box with rounded corners
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box-shadow Property

* Creates drop shadows around layout
elements

* CSS syntax for creating a shadow:

box—-shadow: h-shadow v-shadow blur
spread color 1nset;

* Required: h-shadow and v-shadow attributes
set the horizontal and vertical position of the
shadow in relation to the box

'CDpﬂonakbdur;spread,cxﬂxn;and inset

Empowering your Business
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box-shadow Example

<!doctype html>

<html>

<head>

<title>Rounded Corners</title>

<style type="text/css">

div

{

padding:40px 48px;

background:lightgreen;

width:4@0px;

color: #000;

font-family: sans-serif; =

font-size:yxx-large; A bOX W'th a drop ShadOW
border-radius:25px;
-ms-border-radius:25px;
-moz-border-radius:25px;
-o-border-radius:25px;
-webkit-border-radius:25px;
box-shadow: 1@px 1@px Spx #303080;
margin-left:auto;
margin-right:auto;
margin-top: 1@0px;

¥

</style>

</head>

<body>
<div>A box with a drop shadow</div>
</body>
</html>

Empowering your Business
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Opacity and Transparency

* An opaque item does not let light pass
through, whereas you can see through a
transparent item.

» Syntax for applying a transparency to an
image or other element:
opacity: value
*Value is a floating-point value between 0.0
(100% transparent) and 1.0 (100% opaque)

Empowering your Business
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Transparency Example

Original With transparency

Photo: © AVTG/iStockphoto
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CSS Gradients

*Gradient is a smooth change of colors,
within the same hue or starting with one

color and enc
e Used for subt

button embel

ing with a different color

e shading within backgrounds,
ishments, and more

* Created as methods to the CSS background

property

Empowering your Business
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Gradient Examples

Linear gradient: background:
linear—-gradient (black, white);

A ,radient from black to white

Radial gradient: radial-gradient (50% 50%, 70%
70%, #99CCFF, #3D52606) ;

Empowering your Business
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2D and 3D Transtormations

* A transform is an effect that lets you change the
size, shape, and position of an element.

* Transformations use the transform property.

= Methods: matrix, perspective, rotate,
scale, skew, translate

* To see the "action” of a transformation requires
JavaScript; using only CSS shows the betore
and after effects of properties and their values.

Empowering your Business
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Transformations Sample

<div
<div
<div
<div

class="blue"><p>Hello</p></di HTML @
class="green"><p>Hello</p></ai.-
class="purple"><p>Hello</p></div>
class="red"><p>Hello</p></div>

JAVASCRIPT &
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div {
width:100px;
height:100px;
margin:25px;

}
.blue {
background-color:blue;
transform:rotate(45deg);
}
.green {
background-color:green;
transform:translate(50px,0px );
}
.purple {
background-color:purple;
transform:scalege.sl;
}
.red {
background-color:red;
transform:skew(20deg,30deg) rotate(30deg);
}




CSS Transition

* A transition is a change from one thing to
another; in CSS, a transition is the change in
an element from one style to another.

* |n CSS3, the action of a transition renders
onscreen—no JavaScript is needed!

*The transition property requires the CSS
property to be acted upon during the
transition.

Empowering your Business
S SoftServe | i,



Transition Sample

<div> i
div o | HTML © div { .
Transition is cool (hover over ., background:white;

</div> border:1px solid #aaa;
margin:10px;
padding:10px;
width:330px;
transition:transform 0.7s ease-in-out;

JAVASCRIPT £ }

div:hover {
cursor:pointer;
transform:scale(2) rotate(180deg);

Transition is cool (hover over me)

http://jsfiddle.net/koldovsky/PkljaD/357/

Empowering your Business
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CSS Animation

CSS animations animates transitions between CSS styles to another.

Consist of two components: a style describing the CSS animation and a set of keyframes that
indicate the start and end states of the animation's style, as well as possible waypoints.
There are three key advantages to CSS animations over traditional script-driven animation:

* Easy to use for simple animations.

* The animations run well, even under moderate system load. The rendering engine can use
frame-skipping and other techniques to keep the performance as smooth as possible.

* Letting the browser control the animation sequence lets the browser optimize performance
and efficiency by, for example, reducing the update frequency of animations running in tabs

that aren't currently visible.

Some cool samples:
http://webdesign.tutsplus.com/articles/15-inspiring-examples-of-css-animation-on-codepen-

-cms-23937

Details: https://css-tricks.com/almanac/properties/a/animation/

Empowering your Business
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Simple Animation Example

<div id="spin"> dkeyframes spinnerRotate

HTML &
<p>("-")</p> {
</div> from{transform:rotate(0deg);}
to{transform:rotate(360deg);}
}
#spin{
position: fixed;
top: 10px;
left: 10px;
animation-name: spinnerRotate;
animation-duration: 2s;
animation-iteration-count: infinite;
animation-timing-function: linear;
}

JAVASCRIPT © \[\J\\

http://jsfiddle.net/koldovsky/e2tt2mao/56/
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Timing Functions

<div id="divi1">linear</div> padding-left: 20px;

HTML & .
<div id="div2">ease</div> margin: 10px 0O;
<div id="div3">ease-in</div> color:white;
<div id="div4">ease-out</div> font: 1l4px Georgia;
<div id="div5">ease-in-out</div> vertical-align: middle;

background:#05f;
animation: width 5s infinite;

#divl {animation-timing-function: linear;}
#div2 {animation-timing-function: ease;}
#div3 {animation-timing-function: ease-in;}

linear

JAVASCRIPT &
ease-in

ease-out

ease-in-out

Details:

Empowering your Business
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SVG Filters Support

*  Small file sizes that compress well

 Scales to any size without losing clarity (except very tiny)

* Looks great on high-res displays

* An SVG filter is a set of operations that use CSS to style or otherwise modify an SVG graphic
* The enhanced graphic is displayed in a browser while the original graphic is left alone.

Sample: http://codepen.io/chriscoyier/pen/evcBu

Step-by-step guide: hitps://css-tricks.com/using-svg/

Empowering your Business
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Styling forms

http://webdesign.tutsplus.com/tutorials/bring-your-forms-up-to-dat
e-with-css3-and-html5-validation--webdesign-4738

Step 16: Sit Back and Admire Your Beautiful HTML5 Form

Go ahead and take a look at your final product!

=

8006 HTMLS Contact Form o

Q)ntact US * Denotes Required Field

Name: | John Doe (-] ’

Email: I john_doe@email.com o l

Website: [ http://johndoe.com OI

Message: Congratulations John Doe, you've completed this form!

@
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Styling Tables

http://www.w3schools.com/css/css_table.asp

CSS Tables

« Previous Next Chapter »

The look of an HTML table can be greatly improved with CSS:

N S R

Alfreds Futterkiste Maria Anders Germany
Berglunds snabbkop Christina Berglund Sweden
Centro comercial Moctezuma Francisco Chang Mexico
Ernst Handel Roland Mendel Austria
Island Trading Helen Bennett UK
Koniglich Essen Philip Cramer Germany
Laughing Bacchus Winecellars Yoshi Tannamuri Canada
Magazzini Alimentari Riuniti Giovanni Rovelli Italy

Empowering your Business
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CSS Regions

* Feature allows developers to dynamically
flow content across multiple boxes, or
containers, in HTML documents with fluid
layouts

» Content adjusts and displays properly
whether viewed on large or small

Empowering your Business
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Content Flow with CSS Regions

Lorem ipsum dolor sit amet, Ut tempus enim sit amet lorem orbi viverra scelerisque
consectetur adipiscing elit. feugiat sit amet eleifend velit scipit. Quisque purus metus,
Mauris id dui nisl, vitae congue pretium. Nulla facilisi. Phasellus  Jullamcorper eu scelerisque eu,
est. Nulla molestie sollicitudin ultricies lobortis gravida. mollis a ipsum. Sed ut augue
ligula, eu suscipit lorem. Sed Praesent pharetra ligula vitae accumsan leo pulvinar ultrices
molestie posuere suscipit. nunc lacinia quis accumsaneros | atet ipsum. Curabitur sit amet
Nullam ornare est sed n” tincidunt. Sed tellus massg mi eu justo congue Q
lacinia a lobortis enim mOWs. euismod ullamcorper vitac®®isJ condimentum. Sed ne®®¥ci._

Vestibulum semper nisl quis ligula scelerisque facilisis. Aliquam pretium, justo ut egestas commodo, est
ligula egestas tortor, id ullamcorper nibh odio ultricies urna. Donec dictum mi eget eros sagittis in
tincidunt eros vestibulum. Sed at mauris non mauris semper scelerisque. Sed congue semper elit in
viverra. In eget sapien neque, a tempor augue. In enim quam, sagittis at interdum nec, mollis eget est.

Empowering your Business
through Software Development
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CSS Exclusions

* Formerly referred to as positioned floats

* Enables positioning of images, text, and
boxes anywhere in an HTML document and
wrapping of text completely around these
elements

» Can control the position of a float precisely,

at a specified distance from the top, bottom,
left, or right sides of a container

Empowering your Business
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CSS Exclusions Example 1

This is an element formatted into 2 columns using C553 Multicolumn  are designed to coordinate with the overall look of your document. You

can use these galleries to insert tables, headers, footers, lists, cover pages,
On the Insert tab, the galleries include items that are designed to and other document building blocks. When you create pictures, charts, or
coordinate with the overall look of your document. You can use these diagrams, they also coordinate with your current document lock. You can
galleries to insert tables, headers, footers, lists, cover pages, and other easily change the formatting of selected text in the document text by
document building blocks. When you create pictures, choosing a look for the selected text from the Quick
charts, or diagrams, they also coordinate with your Styles gallery on the Home tab. You can also format
current document look. You can easily change the text directly by using the other controls on the Home
formatting of selected text in the document text by tab. Most controls offer a choice of using the look
choosing a look for the selected text from the Quick from the current theme or using a format that you
Styles gallery on the Home tab. You can also format text specify directly. To change the overall look of your
directly by using the other controls on the Home tab. document, choose new Theme elements on the Page
Most controls offer a choice of using the look from the Layout tab. To change the looks available in the Quick
current theme or using a format that you specify directly. Style gallery, use the Change Current Quick Style Set
To change the overall lock of your document, choose new command. Both the Themes gallery and the Quick
Theme elements on the Page Layout tab. To change the Styles gallery provide reset commands so that you
looks available in the Quick Style gallery, use the Change can always restore the look of your document to the
Current Quick Style Set command. Both the Themes original contained in your current template. On the
gallery and the Quick Styles gallery provide reset commands so that you Insert tab, the galleries include items that are designed to coordinate with
can always restore the look of your document to the original contained in the overall look of your document. You can use these galleries to insert
your current template. On the Insert tab, the galleries include items that tables, headers, footers, lists, cover pages, and other document building

Screen shot from Internet Explorer 10 Test Drive Web page

Empowering your Business
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CSS Exclusions Properties

» wrap-flow:both displays content on all sides of
the exclusion

e wrap-flow:clear displays content above and
below the exclusion but leaves the sides blank

* shape-inside and shape-outside define the
content and the general shape of an exclusion,
respectively

 —-ms- vendor prefix required for Internet Explorer
10; Exclusions not supported in Internet Explorer 9

Empowering your Business
S SoftServe | i,



CSS Exclusions Example 2

Vestibulum semper nisl quis ligula
scelerisque facilisis. Aliqguam
pretium, justo ut egestas commodo,
est ligula egestas tortor, id
ullamcorper nibh odio ultricies urna.
Donec dictum mi eget eros
sagittis in tincidunt eros
vestibulum. Sed at

mauris  non  mauris

semper scelerisque. Sed

congue semper elit in

viverra. In eget sapien

neque, a tempor augue.

In enim quam, sagittis at
interdum nec, mollis eget est. Duis
ac nulla libero. Sed cursus lao
laoreet tortor nec varius. Aenean
aliquet neque quis velit ornare at
commodo a tortor tempus. Nunc
blandit turpis nisi. Aliquam metus
mi, gravida sit amet gravida eget,

dapibus vitae neque. Praesent

tempus  pulvinars  ipsum, vel

hendrerit enim placerat non. Donec

scelerisque tincidunt diam et

condimentum. Donec feugiat purus

sed diam tempus elementum

in eu elit. Cras euismod,

erat at interdum

dignissim, velit sapien

euismod  turpis, at

pretium urna metus

vitae  metus. Cras

blandit, sem ut bibendum

aliquam, lacus lacus aliquet

ante, non fringilla dui sapien ut

nibh. Donec ac magna tortor. Etiam

diam nulla, rhoncus ac bibendum sit

amet, porttitor a quam. Fusce at leo

in diam pellentesque suscipit.

Quisque mattis facilisis massa, in
commodo felis pretium ac.

Empowering your Business
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CSS Exclusions Step-by-step

. omm
J/ W Css Excusions x )

€ - C | [ galjotsi/css-exclusions w =

-

Examples of wrap-flow values

Lorem ipsum dolor sit amet, consectetuer adipiscing elit.
Maecenas porttitor congue massa. Fusce posuere, magna
sed pulvinar ultricies, purus lectus malesuada libero, sit
amet commodo magna eros quis urna. Nunc viverra
impe[djet enim. Fuisce est Vivamnis a telhis.

Pellentesque ha Donec metus :ctus et netus ]
36 et malesuadafa: o a, mollis vel, © pharetra B
S nonummy pede 1 eclorem. In
= porttitor. Done- *6MPUs placerat, . gyspendisse
dui purus, scele: vestibulum yretium mattis,
4 nunc i : i J
. Maurs eg condimentum, ‘clmfend'. Ut
g+ nonu.rnmy. Fusce ALYULL PLULC oL peoe. DllSPCndlSSC

dapibus lorem pellentesque magna. Integer nulla. Donec

blandit feugiat ligula. Donec hendrerit, felis et imperdiet
‘ 24 l euismod, purus ipsum pretium metus, in lacinia nulla
m nisl eget sapien. Donec ut est in lectus consequat

#exclusion { wrap-flow: auto; }

Source: CSS Exclusions and Shapes Module Level 3.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit.

Maecenas porttitor congue massa. Fusce posuere, magna

sed pulvinar ultricies, purus lectus malesuada libero, sit

amet commodo magna eros quis urna. Nunc viverra bt
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border-radius Property, Single
Corners

* Rounding a single corner of a box:
» border-top-left-radius
* border-top-right-radius
* border-bottom-right-radius

= border-bottom-left-radius

Single rounded corner, top right

Single rounded corner, top left

Single rounded corner, bottom left Single rounded corner, bottom right
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CSS GCradient Methods

» CSS3 gradient methods:

= linear-gradient: Creates a gradient from top to
bottom or vice versa, or from corner to corner

» radial-gradient: Creates a gradient that radiates
out from a central point

= repeating-linear-gradient: Creates a
repeating linear gradient, which results in straight
bands of gradient color

= repeating-radial-gradient: Creates a
repeating radial gradient, which results in circular
bands of gradient color

Empowering your Business
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Gradient Color Interpolation and Color
Stops

» CSS gradients support color interpolation in
the alpha color space

= Part of the red blue green alpha (RGBA) color
model

* Can specity multiple color stops, with an
RGBA color and position for each one

* Example of the use of rgba colors:

linear—-gradient (to right,
rgba (255,255,255, 0)
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2D Translation

* To translate an element means to move it
without rotating, skewing, or otherwise turning
the image.

* Use the translate () method in CSS and
provide x- and y-axis values to position the
element relative to its original or default
position.

= X-axis value specifies the left position of the
element

= y-axis value specifies the top position.
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2D Translation Example

<!doctype html>

<html>

<head>

<style type="text/css">

div

1

padding:2@px 20px;

background:limegreen;

width:15@px;

height:75px;

color:#fff;

font-family:sans-serif;

font-size:xx-large;

¥

div#div2

1

transform:translate(100px,5@px);
-ms-transform:translate(10@px,50px); /* IE 9 */
-moz-transform:translate(1@0px,50px); /* Firefox */
-webkit-transform:translate(10@px,50px); /* Safari and Chrome */
-o-transform:translate(100px,560px); /* Opera */
¥

</style>

</head>

<body>

<div>Original position</div>

<div id="div2">Translated position</div>
</body>

</html>

Empowering your Business
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2D Translation Example

Original
position

Translated
position

-gj S oft S e rv e Empowering your Business



2D Scaling

* To scale an element is to increase or decrease
Its size.

* Use the scale () method in CSS and provide
x-axis (width) and y-axis (height) values.

* The example on the following two slides
increases the width of the element two times its
original size, and increases the height four times
its original size:

transform: scale(2,4);
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2D Scaling Example

<!doctype html>

<html>

<head>

<style type="text/css">

div

{

padding:1@px 10px;
background:limegreen;

width:10epx;

height:5@px;

color:#fff;

font-family:sans-serif;

font-size: x-large;

¥

div#div2

{

margin:200px;

transform:scale(2,4);
-ms-transform:scale(2,4); /* IE 9 */
-moz-transform:scale(2,4); /* Firefox */
-webkit-transform:scale(2,4); /* Safari and Chrome */
-o-transform:scale(2,4); /* Opera */
}

</style>

</head>

<body>

<div>Original element</div>

<div id="div2">Scaled element</div>
</body>

</html>
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2D Scaling Example

Original
element

Scaleo

element




2D Rotation

* To rotate an element turns it clockwise by a

S
° L
S

oecifled number of degrees.
se the rotate () method in CSS and

o T

oecify the degrees of rotation.
he example on the following two slides

rotates an element by 30 degrees in the 2D

P

lane:

transform: rotate (30deq);
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2D Rotation Example

<!doctype html>

<html>

<head>

<style type="text/css">

div

1

padding:4@px 40px;
background:limegreen;

width:15@px;

color:#fff;

font-family:sans-serif;

font-size: xx-large;

¥

div#div2

1

margin:108px;

transform:rotate(30deg);
-ms-transform:rotate(3@deg); /* IE 9 */
-moz-transform:rotate(3@deg)); /* Firefox */
-webkit-transform:rotate(3@deg); /* Safari and Chrome */
-o-transform:rotate(3@deg); /* Opera */
}

</style>

</head>

<body>

<div>Original element</div>

<div id="div2">Rotated element</div>
</body>

</html>
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2D Example

Original
element
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3D Rotation

* 3D rotation uses the rotatex () and
rotateY () methods.
» rotateX (): Element rotates around its x-axis
* rotateY (): Element rotates around its y- axis
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2D Skewing

e To skew an element is to stretch it in one or
more directions.

* Use the skew () method and provide x-axis
and y-axis values, in degrees, to create an
angular shape.

* The example on the following two slides
turns an element 20 degrees around the
x-axis and 30 degrees around the y-axis:
transform: skew(20deg, 30deqg) ;
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2D Skewing Example

<!doctype html>

<html>

<head>

<style type="text/css">

div

1

padding:4@px 40px;

background:limegreen;

width:15@px;

color :#fff;

font-family:sans-serif;

font-size:xx-large;

¥

div#div2

1

margin:1008px;

transform:skew(2@deg, 3@deg);
-ms-transform:skew(2@deg,3@deg); /* IE 9 */
-moz-transform:skew(2@deg,30@deg); /* Firefox */
-webkit-transform:skew(2@deg,3@deg); /* Safari and Chrome */
-o-transform:skew(2@deg,3@deg); /* Opera */
¥

</style>

</head>

<body>

<div>Original element</div>

<div id="div2">Skewed element</div>
</body>

</html>
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2D Skewing Example

Original
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3D Skewing

* 3D skewing uses the skewx () and skewY ()
methods to skew an element around its
X-axis and y-axis, respectively.

* As an example, the following code skews an
element 45 degrees:
transform: skewX (45deq) ;
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3D Perspective

* The CSS3 3D perspective property defines
how a browser renders the depth of a 3D
transformed element.

* The property takes on a number value:
lower values (in the range of 1to 1000)
create a more pronounced effect than
higher values.
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Transition Example

<!doctype html>

<html>

<head>

<style type="text/css">

#wrapper {
padding: 4@px 4@px;
background: #B836@B;
width: 200px;
color: #fff;
font-family: sans-serif;
font-size: xx-large;
margin-left: auto;
margin-right: auto;
margin-top: 1@@px;
-webkit-transition-property:opacity;
-webkit-transition-duration:3s;
-webkit-transition-delay:1s;
-webkit-transition-timing-function:1linear;

Empowering your Business
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#wrapper #before, #wrapper:hover #after { -webkit-opacity: 1; }
#wrapper:hover #before, #wrapper #after { -webkit-opacity: @; }

</style>
</head>

[<body>
[<div id="wrapper">
<div id="before">Now you see me</div>
<div id="after">Now you don't</div>
</div>
</body>
</html>



Transition Example

Now you see Transition
me >

Now you don't
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Animation (Continued)

* Specifty a CSS style within the @keyframes
rule

* An example of a rule for a fadeout:
dkeyframes fadeout {
from { opacity: 1; }
to { opacity: 0; }
}
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Animation (Continued)

» Code snippet that configures animation
properties for a fadeout:
div { animation-duration: 3s;
animation-delay: 0Os;
animation-timing-function: ease; }

div:hover { animation—-name: fadeout; }
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SVG Filters

* An SV filter is a set of operations that use
CSS to style or otherwise modify an SVG
graphic.

* The enhanced graphic is displayed in a
browser while the original graphic is left
alone.
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SVG Filters

» feBlend

» feColorMatrix
 feComponentTranstfer
» feComposite

» feConvolveMatrix

- feDiffuseLighting

» feDisplacementMap
» feFlood

» feGaussianBlur

* felmage

* feMerge

([~ -~ v ‘ Empowering your Business
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SVG Filters Gaussian Blur Example

<!doctype html>
<html>
<head>
<meta charset="utf-8" />
<title>SVG Gaussian Blur Example</title>
<style type="text/css">
</style>
</head>
<body>
<svg>
<defs>
<filter id="al" x="@" y="@">
<feGaussianBlur in="SourceGraphic" stdDeviation="20" />
</filter>
</defs>
<rect width="150" height="15@" stroke="plum"
stroke-width="3" fill="plum" filter="url(#al)" />
</svg>
</body>
</html>
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SVG Filters Offset Example

<!doctype html>
<html>
<body>
<svg>
<defs>
<filter id="il" x="0@" y="@">
<feOffset dx="5" dy="5" />
</filter>
</defs>
<rect width="15@" height="158" fill="grey"
filter="url(#i1)" />
<rect width="15@" height="150" fill="plum" />
</svg>
</body>
</html>
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Canvas

» Use canvas to draw pixel-based shapes.

* The canvas element accepts only two
attributes—height and width.

* You can use most CSS properties to style
the canvas element, adding color, gradients,
pattern fills, transformation, animation, and
much more.

Empowering your Business
S SoftServe | i,



Canvas Example 1

<!doctype html>
<html>
<head>
<meta charset="UTF-8">
<title>Canvas Example</title>
<script>
l function f1() {
var canvas =
document.getElementById("smlRectangle");
context = canvas.getContext("2d");
var grd = context.createlLinearGradient(@, @, 15@, 9);
grd.addColorStop(@.3, "coral");
grd.addColorStop(@.7, "khaki");
context.fillStyle = grd;
context.fillRect(10, 20, 200, 100);
¥
</script>
</head>
<body onload = "f1();">
<canvas id="smlRectangle"” height="3@0"' width="500">
</canvas>
</body>
</html>
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Canvas Example 2

e context.rotate (20*Math. PI/180);
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Canvas Example 3

<!doctype html>
<html>
<head>
<meta charset="utf-8" />
<title>Canvas Text</title>
</head>
<body>
<canvas id="myText" width="400" height="25@" style="border:3px solid #@@@OFF;">
</canvas>
<script type="text/javascript">
var canvas = document.getElementById("myText");
context = canvas.getContext("2d");
context.font = "3@px Arial”;
context.strokeText("Canvas-generated text™, 40, 120);
</script>
</body>
</html>
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Contacts

Europe Headquarters

52 V. Velykoho Str.
Lviv 79053, Ukraine

Tel: +380-32-240-9090
Fax: +380-32-240-9080

E-mail: info@softserveinc.com
Website: www.softserveinc.com

Thank You!
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